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Course Outline:
1. Introduction to Computer 

2. Intro to Operating System

3. Intro to Microsoft word

4. The Most common keys on Keyboard
5. Important question about Windows

6. Important question about Internet

7. The most common computer abbreviation

1. Introduction to Computer
What is Computer?
Computer is an electronic machine that gets input from the user, and after processing shows output. It works like a brain of human.
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Example:

 
Computer has 4 main devices:

i. Input Devices   

ii. Output Devices


iii. 
Processing Devices 

iv. Storage Devices

I. Input Devices:
The devices that are used to give commands to computer are called input devices.

Example:



Mouse, Keyboard, Scanner etc.
II. Output Devices:
The devices that are used to shows result are called output devices.

Example:



Monitor, Speakers, Printer etc.
III. Processing Device:
The device that is used to processes on given commands is called Processing Device.

Example:

C.P.U

IV.  Storage Devices:
The devices that are used to save or store data are called Storage Devices.

Example:

Hard Disk, USB, Floppy Disk, Compact Disk etc.
Computer Architecture
A computer is a combination of various components. The way in which computer components are connected with one another is called computer architecture.

Components of computer
i. CPU   



ii. Main Memory


iii. 
Input/output unit

iv. Bus interconnection
I. CPU

CPU stands for central processing unit. It is the brain of the computer. it is the most important component of the computer. it is also called processor. CPU consists of two main units known as arithmetic & logical unit (ALU) and control unit (CU).

ALU (Arithmetic & Logical unit)
ALU is the part of the CPU. Actual execution of instructions takes place in this part. All arithmetic and logical operations are performed here.
CU (control unit)

CU is important component of CPU. It acts likes a supervisor of the computer. it controls all the activities of computer.
II. Main memory

Main memory is an important component of computer system. It is used to store program and data that are being executed. It is also known as working area of computer system. 
III. Input/output unit
I/O unit controls processor’s communication with peripheral devices such as monitor, drive and printer 

IV. Bus interconnection

A computer system consists of CPU, main memory and I/O units. These components have to be connected to transfer data from one component to another. The use of buses to connect different components is known as bus interconnection.
Difference between software and hardware:

I. Software:

A set of instructions given to computer to solve the problems is called Software. 
It has two types:

i. System Software (Windows, DOS. etc.)
ii. Application Software (MS. Word, Excel, Paint etc.)
II. Hardware:

All the components of computer that we can see, feel and also touch is called hardware.
Example:

Keyboard, mouse, C.P.U, Monitor etc.

2. Introduction to Microsoft word
Microsoft office mainly consists of office application such as word (word processing), Excel (Spread Sheet), Power Point (Presentation) and Access (Database).
What is MS- Word?

MS-Word stands for Microsoft Word. Microsoft is the name of a company that provides us software and all the programs of computer are called software. MS-Word processing is the most commonly used software that allows from students to business professionals to produce research papers, reports, news, letters, brochures and other documents with word application. MS-Word can perform variety of tasks such as correcting text, editing text, Spell checking, Grammar checking, formatting text, bulleting text and inserting any kind of shapes or drawing etc. moreover user can save and print their documents for their use.
 Options related to file:
1. New:    
 
Through this option we can insert a new file or document in this program.

Syntax:
Alt + F + N
or

Ctrl + N
· Click on New in Office Button.

· A dialog box will appears and click on blank documents in this menu.
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2. OPEN:
Through this option we can view any already saved file on the screen in this program.

Syntax:

Alt + F + O
or

Ctrl + O

· Click on Open in Office Button.

· You can open a file by throwing double click on the name of file from the box.

· Click on open command under given dialog box appears.

· Select the name of file and then click on Open button.

· Tab Key is used to go to next option available in dialog box.

· Shift + Tab key is used to jump to previous option in dialog box.
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3. CLOSE:    
 
Through this option we can close any open or new file in this program.

Syntax:

Alt + F + C

· Click on close Command in Office Button.

· If you have not saved file computer will automatically ask you weather to save file or not? 
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SAVE:    
 
Through this option we can save a new document or file with any name in this program.

Syntax:

Alt + F + S

or

Ctrl + S
· Click on save command in Office Button.

· If you have not specified any name to file, then under given dialog box appears.

· If you don’t specify name of file computer will automatically save it considering first line of the document as name. If nothing is written in document, it will name it as DOCn. Whereas N stand for any number 1,2,3,4 (Doc1, Dic2, etc.
· When we click on save button following dialog box will appear.
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5. SAVE AS:    
 
Through this option we can save any already saved file with a different name in this program.

Syntax:

Alt + F + A


· Click on save as command in file menu.

· A dialog box same as above screen will appear, give a new name and press save.
6. PAGE SETUP:    
 
Through this option we can adjust setting of any page for printing in this Document.
Syntax:

Alt + P + SP
· Click on Page Layout menu.

· Then click on page setup and a dialog box will appear on the screen. 

It has the Following Options.

Margins

· Through this option we can leave page from Top, Bottom, Left and Right.
Paper Size

· Through this option we can select different size of papers. Commonly used paper sizes are Letter Size (8.5 Width, 11 Height) and Legal Size Papers (8.5 Width, 14 Height).
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We can view paper in two different forms as Portrait (Height Wise) and Landscape (Width Wise). 
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Through this option we can view any document before printing.
Syntax:

Alt + F + W + V
· Click on the Office Button.

· Click on the print and then select print preview option

· Preview windows will appear as under.
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In Preview windows we have some tools. 
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This Icon is used to print the opened document.
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  This Icon is used to view the MS. Word Options like display, proof.
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 These are used to check and manage the page setup like 
giving margins setting the layout of page orientations and the select the size of page. 
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This Icon is used to Open the zoom dialog box to specify the zoom level of the document.
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Zoom the Document to 100% of the normal size.
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This Icon is used to Zoom the document so that an entire page fits in the window.
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This Icon is used to Zoom the document so that two pages fits in the 
window.
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This Icon is used to Zoom the document so that the width of the page 
matches the width of the window.
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This Icon is used to View the Rulers, used to measure and line up 
objects in the documents. 
9.
 PRINT:    
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Through this option we can Print any selected document on the paper (we can change the soft copy into hard copy).

Syntax:

Alt + F + P
   or    Ctrl + P


· Click on Print command in file menu.
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A dialog box will appear, select the page range option and then press ok to get the copy of any selected paper or sheet.
7. Exit Word:

Through this option we can close any opened file with program (to come out from the program.

Syntax:
   Alt + F4


· Click on Exit Word Option in Office Button at the end of drop down menu.
Home Tab:
Editing in document:
1.  Undo:    [image: image16.png]



 

Through this option we can cancel or reverses the last action in the file.
Syntax:


Ctrl + Z
· Click on Undo button in the Quick Access Toolbar. [image: image17.emf]
2.  Redo:    [image: image18.png]



 

This option is used as a reverse of undo option in the file.

Syntax:


Ctrl + Y
· Click on Undo button in the Quick Access Toolbar.
3.  Cut:    
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Through this option we can move any selected text from one place to any other selected place in the file.

Syntax:


Ctrl + X
· Click on Home Tab.

· Click on Cut Command from the Clipboard (Groups Categories)

4.  Copy:    
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Through this option we can make more than one copies of any selected text.
Syntax:


Ctrl + C
· Click on Home Tab.

· Click on Copy Command from the Clipboard (Groups Categories)
5.  Paste   
 [image: image21.png]



Through this option we can place any cut or copied text to any selected place in the document.

Syntax:


Ctrl + V
· Click on Home Tab.

· Click on Paste Command from the Clipboard (Groups Categories)
6.  Paste Special:    
 

Through this option we can place any cut or copied text with its complete format (table, colors, etc) to any selected place in the document.

Syntax:

Alt + H + V + S
· Click on Home Tab.

· Click on Paste Command Drop down menu from the Clipboard (Groups Categories)
7.  Clear Formatting:  [image: image22.png])
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Through this option we can clear FORMATS (only back color and text color and all types formatting) to any selected text.

Syntax:

Alt + H + E


· Click on Home Tab.

· Click on Clear Formatting Command from the FONT (Groups Categories)
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Through this option we can select all the text or all types of data like shapes and snaps at once in the document.

Syntax:

Ctrl + A
(Select Objects):  Use Select object to allow you to select objects that have 

been positioned behind the text.
(Select Text with similar formatting):  Use Select Similar formatting to allow 
you to select Text that has been similar formatting. 

· Click on Home Tab.

· Click on Select Command from the Editing (Groups Categories)
9.  Find:    
 

Through this option we can find or search any text from the sheet.
Syntax:


Ctrl + F
· Click on Home Tab.

· Click on Find Command from the Editing (Groups Categories)
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10.  Replace:    
 

Through this option we can replace or change any find text with any suitable word in the document.

Syntax:

Ctrl + H
· Click on Home Tab.

· Click on Replace Command from the Editing (Groups Categories)
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11.  Go To:    
 

Through this option we can move or jump to any selected page or line at once in the document.

Syntax:


Ctrl + G
· Click on Home Tab.

· Click on Find Command(Drop down menu) from the Editing (Groups Categories)
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Formatting document:
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1.  Font:    
 

Through this option we can set the formatting of any selected text in this document or file.

Syntax:
Alt + O +F
 or
 Ctrl + D

· Click on Home Tab.

· Click on FONT Command (Dialog Box Launcher) from the FONT (Groups Categories)
· A dialog box will appear
· Select the required formatting and press Ok.
2.  Character Spacing:    
 

Through this option we can set the character spacing of any selected text in this document.

Syntax:

Ctrl + D


· Click on Home Tab.

· Click on FONT Command (Dialog Box Launcher) from the FONT (Groups Categories)
· Select the character spacing Option in Format menu.
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3.  Paragraph:    
 

Through this option we can apply different settings to a selected paragraph. For example, we can increase/decrease the line spacing and also change the alignment of a selected paragraph in the sheet. 
Syntax:

Alt + H + PG


· Click on Home Tab.

· Click on (Dialog Box Launcher) from the Paragraph (Groups Categories)
· Select the required paragraph formatting and press OK.
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4.  Bullets & Numbering:    
 

Through this option we can apply bullets and numbers to any selected paragraph or line in the sheet.
Syntax:
(For Bullets)
Alt + H + U

(For Numbers)
Alt + H + N
· Click on Home Tab.

· Click on Bullets & Numbers Command from the Paragraph (Groups Categories)
· Select the desire bullets and number Select any Bullets or Number style and press ok.
5.  Borders and Shading:    
 

Through this option we can give Borders to a selected text of different styles and colors and also to a whole page by selecting page border option and through shading option we can give any selected color shade to a page. 

Syntax:

Alt + P + PB


· Click on Page Layout Tab.

· Click on Page Borders Option from the Page Background (Groups Categories)
· Select the required Tab (Borders, Page Border or Shading) Makes formatting and press OK.
[image: image26.png]1
g

m
{
B





[image: image58.png]Shadng styes Varionts
© Horzontal
© verteal

© Diagonal up
© Diagonal down Sample:

O zemeomer -

© From center

[ Rotate fil effect with shape




6.  Columns:    
 

Through this option we can divide a page in to number of columns in this document.

Syntax:

Alt + P + J + C


· Click on Page Layout Tab.

· Click on Columns Option from the Page Setup (Groups Categories)
· Select the column One, Two, Three and press Ok to apply this in the Sheet.
7.  Drop Cap:
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Through this option we can drop the first letter of the selected paragraph or line as capital in the document.

Syntax:

Alt + N + RC 


· Click on Insert Tab.

· Click on Drop Cap Option from the Text (Groups Categories)
· Select the drop letter and press Ok.

· If we want to drop more than three lines before cap, then give line numbers in the Lines to drop.
· If we want to give distance the text to cap, then type the distance number in inches in distance from text.

8.  Text Direction:
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On the Insert tab, the galleries include items that are designed to coordinate with the overall
look of your document. You can use these galleries to insert tables, headers, footers, lists, cover
pages, and other document building blocks. When you create pictures, charts, or diagrams, they
also coordinate with your current document look. You can easily change the formatting of
selected text in the document text by choosing a look for the selected text from the Quick Styles
gallery on the Home tab.

You can also format text directly by using the other controls on the Home tab. Most controls

offer a choice of using the look from the current theme or using a format that you specify
directly. To change the overall look of your document, choose new Theme elements on the
Page Layout tab. To change the looks available in the Quick Style gallery, use the Change
Current Quick Style Set command.

Both the Themes gallery and the Quick Styles gallery provide reset commands so that you can
always restore the look of your document to the original contained in your current template. On
the Insert tab, the galleries include items that are designed to coordinate with the overall look of
your document. You can use these galleries to insert tables, headers, footers, lists, cover
pages, and other document building blocks. When you create pictures, charts, or diagrams, they
also coordinate with your current document look.




Through this option we can change the direction of any text written in the text box. 
Syntax:

Alt + JX + G 

· First select the text box in insert Tab
· Take text box and a Format Tab appear on top select it and then go to the Text (Groups Categories. Here we find text direction option.
· Click on Text direction option change the direction of your text and press OK. 
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the selected text from the Quick Styles gallery on the Home tab.

You can also formt text directly by using the other controls on the Home tab. Most controls offer a choice of using the look from the current theme or using a format that you specify directly. To change the overall look
of your document, choose new Theme elements on the Page Layout tab. To change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.
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9.  Change Case:

Through this option we can change the alphabetic case of any selected text in this document.

Syntax:

Alt + H + 7


· Click on Home Tab.

· Click on Change Case Option from the Font (Groups Categories)
· Select any Case and press Ok.
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Syntax: A+V+K ctrl + F1

6

Click on Task Pane Option in View menu and look at the following Bar in
this file.

Through this option we can nsert or remove any selected bar in this fle.

Syntax: AR+V T

Syntax: Al 4V L

Ciick on Tool Bars Option in View menu then cick any bar to insert or
remove in this document.

“Through this option we can hide or view the ruler bars on the screen in this
document.

Click on Ruler Option in View menu throu



10.  Background Page Color:

Through this option we can apply any background color in the sheet.

Syntax:

Alt + P + PC


· Click on Page Layout Tab.

· Click on Page Color Option from Page Background (Groups Categories)
· Select any Color for apply on the sheet as a background color.
More Color:
This is the sub option of background color. Through this option we can change the background color of the page by making color combination through RGB (Red, Green and Blue) in the sheet.
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# Click on Task Pane Option in View menu and look at the following Bar in
this file.
6. Tool Bars:
Through this option we can insert or remove any selected bar in this file.
Syntax: AR+V+T
# Click on Tool Bars Option in View menu then click any bar to insert or

remove in this document.

7. Ruler:
Through this option we can hide or view the ruler bars on the screen in this
document.
Syntax: Alt+V +L
< Click on Ruler Option in View menu through mouse.
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Syntax:

Alt + P + PC + M


· Click on Page Layout Tab.

· Click on Page Color Option from Page Background (Groups Categories)
· Click on Background then click on More Color Option in Format menu and look at the following screen.
· [image: image64.png]


Select any Color for apply on the sheet as a background color.
Fill Effects:
This is the sub option of background color. Through this option we can change the background color of the page by making color combination of two or three colors or by selecting predefined colors from the list.

Syntax:

Alt + P + PC + F


Watermark:
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This is the sub option of background. Through this option we can place any text or picture at the background of the page very lightly appearance.

Syntax:

Alt + P + PW


· Click On Page Layout.
· Click on Watermark option from the Page Background (Group Categories).
· Select any Picture or Click on Custom Watermark then types the text for applying on the sheet as a background.
Viewing documents: 
Documents Views (Groups Categories)    
 
Through this Groups Categories We can view our documents in different layouts Like (Print Layout, Full Screen Reading, Web Layout, Web Layout, Outline, and Drafts).

But for Office work or any type of composing or printing we use always PRINT LAYOUT.

1. PRINT LAYOUT:

Use to view as a print layout format that is the default format.

Syntax:

Alt + W + P


· Click on View Tab.
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Click on Print Layout Option in Document Views (Group Categories) and look at the following screen.

2. Full Screen:    
 

Through this option we can view any current opened file on full screen in this document.

Syntax:

Alt + W + F


· Click on View Tab

· Click on Full Screen Option in Document Views (Group Categories) and look at the screen in this document.
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3.  Web Layout:    
 

Through this option we can view current opened page in Web Format in this document.

Syntax:

Alt + W + L


· Click on View Tab
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Click on Web Layout Option in Document Views (Group Categories) and look at the screen in this document.

4.  Outline:    
 

Through this option we can view outline of the current opened page that is hide both Horizontal & Vertical Ruler Bars form the Screen in this document.

Syntax:

Alt + W + U


· Click on View Tab.
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Click on Out Line Option in Document Views (Group Categories) and look at the screen in this document.
5.  Draft:    
 

View the Document as a draft to quickly edit the text.

Syntax:

Alt + W + E
· Click on View Tab.
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Click on Draft Option in Document Views (Group Categories) and look at the screen in this document.
6.  Show/Hide (Group Categories):    
 

Through this Groups Categories We can view our document’s Ruler, Document Map, Gridlines and Thumbnails.

Syntax:
(For Ruler) 

Alt + W + R


(For Document Map) 
Alt + W + VM

(For Gridlines) 

Alt + W + G

(For Thumbnails) 
Alt + W + H



· Click on View Tab.

· Click on Show/Hide Group Categories then click on desire option.

7.  ZOOM Group Categories:    
 

[image: image70.png]Merge Spiit  Split
Cells Cells  Table




Through this Group Categories we can view our document in different zoom format like (Zoom 100%, One Page, Two Pages and page width).
Syntax:(For Zoom) 

Alt + W + Q

(For 100%) 

Alt + W + J

(For One Page) 

Alt + W + 1

(For Two Pages) 
Alt + W + 2

(For Page Width)
Alt + W + I



· Click on View Tab.

· Click on Zoom Group Categories then click on desire option.

8. Window Group Categories:    
 

Through this Group Categories we can view our document in different Windows format like New Window, Arrange All and Split windows etc.
Syntax:
(For Window) 

Alt + W + N

(For Arrange All) 
Alt + W + A

(For Split Windows) 
Alt + W + S
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INSERT TAB:

This is the sub menu of menu bar that has nearly 11 options in a sequence.

1.  Cover Page:    [image: image28.png]



 

Through this option we can insert a fully-formatted cover page.
Syntax:
Alt + N + V


· Click on Insert Tab.
· Click on Cover Page and select desire Cover Page option.
2.  Blank Page:    [image: image29.png]Blank
Page




 

Through this option we can insert a fully-formatted cover page.

Syntax:
Alt + N + NP


· Click on Insert Tab.
· Click on Blank Page.
3.  Break:    
 [image: image30.png]Page
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Through this option we can view set Page breaks in this document or file.

Syntax:
Alt + N + B
Or
Ctrl + Enter
· Click on Insert Tab.
· Click on Break Option in Insert Group Categories.
3. Tables group categories:
1.  Insert Table:    
 
[image: image72.png]=4

Tedt  Quick Words
Box~ Pats~ -

Bottom of Page
Page Margins
Current position
Eormat Page Numbers.

Remove Page Numbers



Through this option we can insert table with specifying rows and columns in this sheet. And also add column to the entire table (left or right), rows to the entire table (Above and below) and also cells in this document.

Syntax:

Alt + N + T + I

· Click on Insert Tab.

· Click on Insert Table Option in Tables (Group Categories) and look at the following screen.
· Select the required option and then press ok to insert the table.
2.  Draw Table:    
 
Through this option we can draw table by selecting pencil through mouse in the Sheet.

Syntax:

Alt + N + T + D
· Click on Insert Tab. Click on Draw Table Option in Tables (Group Categories) try to draw the table in the sheet.
3.  Convert Text to Table:    
 
Through this option we can convert our selected text into table in the sheet

Syntax:

Alt + N + T + V
· First select the text you want to convert into table.
· Click on Insert Tab. Click on Convert text to table Option in Tables (Group Categories).
4.  Insert Excel Spreadsheet:    
 
Through this option we can Insert Excel Spreadsheet in the Cursor point position.

Syntax:

Alt + N + T + X
· Click on Insert Tab. Click on Insert Excel spreadsheet Option in Tables (Group Categories).
5.  Quick Tables:    
 
Through this option we can Insert Quick Tables that software has already as a template.

Syntax:

Alt + N + T + T

· Click on Insert Tab. Click on Quick Tables Option in Tables (Group Categories) Select the desire table format and do editing.
6.  Rows and Columns:    
 
Through this option we can insert rows and columns in the Selected Tables.

Syntax:


For Delete Cell, Column, Row, Table: 
Alt + JL + D

For Insert above row:
Alt + JL + A

For insert below row:
Alt + JL + E

For insert left column:
Alt + JL + L

For insert right Column:
Alt + JL + R

· Click on table.
· Click on Layout Tab. Click on Rows and Columns (Group Categories) Select the desire option.
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7.  Select Table:    
 
Through this option we can select the table, row, column and cell in the Sheet.

Syntax:

Alt + JL + K
· Then Click on table.
· Click on Layout Tab. Move to table (Group Categories).
· Click on Select cells option. 
· Then Click on desire option.
8.  Merge Cells:    
 
[image: image74.png]Correct Two INital CAptals
Captalze firstletter of sentences
Captaie firstletter of table cels:
Capitalze names of days.

Correct acadental usage of cAPS LOCK key.

Replace textas you type

[(r ) (o= )

(o] (el




[image: image75.png]Unrestricted Access.

() Bestrced access

Manage Credentials



Through this option we can merge or combine different selected cells or we can make one cell of different selected cells through merge cells option.

Syntax:

Alt + JL + M 
· First select the required cells that we have to merge.
· Then Click on table.
· Click on Layout Tab. Move to merge (Group Categories).
· Click on merge cells option.
9.  Split Cells:    
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Through this option we can divide a single cell into different selected cell in this document. 

Syntax:

Alt + JL + P

· First select the required cell that we have to split.
· Click on split Cells Option in Merge (Group Categories)
· Type the required columns and rows and press Ok.
10.  Split Table:    
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Through this option we can divide a table into two tables’ right from the cursor position.

Syntax:

Alt + JL + Q
· First select the required table that we have to split.
· Click on Layout tab.
· Click on split table Option in Merge (Group Categories) and press Ok.
11.  Table Styles:    
 
Through this option we can apply a predefined table style to any selected table.

Syntax:

Alt + JT + S

· Select the required table that we have to format.
· Click on Design tab. 
· Select the desire table style to apply
12.  Sort:    
 
Through this option we can sorts the selected table in required order in ascending or descending i.e. (A to Z or Z to A).

Syntax:

Alt + JL + SO
· Click on Layout tab.
· Click on Sort Option in data (Group Categories) and look at the screen.
· Select ascending or descending option and press Ok.

13.  Table Properties (Table):    
 
Through this option we can set the table, rows, columns and cells setting.

Syntax:

Alt + JL + O
· Click on Layout tab.
· Click on table Properties Option in Table (Group Categories).
· Select the required setting for table adjustment and press Ok.
Continuing Insert Tab. 
4.  Picture (From File):

Through this option we can insert picture from file that already saved in computer.

Syntax:

Alt + N + P


· Click on Insert Tab.
· Moves to Illustrations (Group Categories). Click on Picture then Select any picture from the Memory and press Insert.
5.  Picture (Clip Art):    
 

Through this option we can insert picture from clip art in the sheet.

Syntax:

Alt + N + F


· Click on Insert Tab.
· Moves to Illustrations (Group Categories) Click on Clip Art Option.
·  Type the category name in search option, press Enter and Click any picture that you want to insert in the sheet. 
6.  Picture (Auto Shapes):

Through this option we can insert any shape by selecting any shape style in auto shape bar that will be appear.

Syntax:

Alt + N + SH


· Click on Insert Tab.
· Moves to Illustrations (Group Categories)
· Click on shapes option and look at the following screen.
· Select any shape style and create on a sheet.
7.  Picture (Word Art):

Through this option we can insert picture from Word Art that already saved in this software.

Syntax:

Alt + N + W


· Click on Insert Tab.
· Moves to Text (Group Categories)
· Click on Word Art Option and look at the following screen.
· Select any Art Style then type the text and press Ok.
8.  Text Box:

Through this option we can insert a text box in the sheet in which we can enter our data.

Syntax:

Alt + N + X


· Click on Insert Tab.
· Moves to the Text (Group Categories)
· Click on Text Box then Click on any desire style.
9.  Comment:    
 

Through this option we can give comments to any selected text in this document or file.

Syntax:

Alt + R + C


· Click on Review Tab.
· Moves to Comments (Group Categories). 
· Click on New Comment Option Then write the comments to selected word. 
10. Header and Footer:    
 

Through this option we can view any entered Header and Footer text on each page in the sheet.

Syntax: 
For Header:

Alt + N + H
For Footer:

Alt + N + O


· Click on Insert Tab.

· Moves to Header & Footer (Group Categories). Click on Header OR Footer Option. Type text for Header OR Footer and press enter.
11.  Page Numbers:    
 

Through this option we can insert page number on the top of page or bottom of the page at any position Left, Right or Center in this document.

Syntax:

Alt + N + NU


· Click on Insert Tab.
· Move to the Header & Footer (Group Categories).
· Click on Page Number Option and look at the following screen.
12.  Date and Time:    
 
Through this option we can insert current system date and time at any position on the page in this document or file.

Syntax:

Alt + N + D


· Click on Insert Tab.
· Move to Text (Group Categories) Then Click on Date and Time Option and look at the following screen.
· Select any format and press ok.
· If you click on update automatically check box, then the inserted date and will change as the date and time of the computer changes. 
13.  Symbols:    
 

Through this option we can insert any selected default symbols in the sheet.
Syntax:

Alt + N + U + M


· Click on Insert Tab.
· Moves to Symbols (Group Categories). 
· Click on Symbols Option Then Click on More Symbol and look at the following screen.
· Select any symbol and press ok or insert.
· We can also make syntax of any symbol by using shortcut key in dialog box.
PROOFING.
1.  Spelling and Grammar:    
 
Through this option we can check the spelling and grammar mistakes and corrects them in the Sheet.
Syntax:

Alt + R +S
   or
  F7  
· Click on Review Tab.
· Moves to Proofing (Group Categories)
· Click on Spelling and Grammar Option and look at the following screen.
· Check grammar option then it will check grammatical errors otherwise it will check spelling errors only.
· Ignore this certain spelling
· Ignore all spelling which spell like this current spelling mistake and do not prompt again.
· Add this word in computer’s dictionary for permanent in this computer.
2.  Set Language:    
 

Through this option we can set the language the dictionary will automatically be changed if the language is changed.

Syntax:

Alt + R + U


· Click on Review Tab.
· Moves to Proofing (Group Categories)
· Click on Set Language Option and look at the following screen.
· Default selects the language and click on this button to set the selected language as default language.
· Do not Check spelling or grammar, this selected language dictionary must not check the spelling & grammatical mistakes. 
3.  Word Count:    
 

Through this option we can count the pages, words, characters with space or no space, paragraphs and lines in the Sheet.

Syntax:

Alt + R +W
· Click on Review Tab.
· Moves to Proofing(Group Categories)
· Click on Word Count Option and look at the following screen.
· A dialog box will appear.
· Click on Include footnotes and endnotes if we you want to count the entered date in footnotes and endnotes.
4.  Auto Correct:    
 

Through this option we can corrects some common errors automatic you may do while typing.
Syntax:

Alt + F +I + P+ Tab


· Click on Office Button.
· Click on word options by clicking it a dialog box will appear on the screen
· Click on proofing here then Click on Auto Correct Option and look at the following screen.
· A dialog box will appear.
· Type the incorrect and correct word in this dialog box and press Ok.
5.  Protect Document:    
 

Through this option we can protect (Save) our document from the unauthorized user.

Syntax:

Alt + R +PR+ P


· Click on Review Tab.
· Moves to Protect (Group Categories).
· Click on the Protect Document.
· Choose the desire option and press enter. 
3. The Most Common Keys on Keyboard
Cursor Control Keys:
 Cursor is used to represent the position where the keyboard’s input will be placed. These four arrow keys are used for moving the cursor from its current position to right, left, up, or down. 

ENTER KEY: Used to enter commands or to move the cursor to the beginning of the next line.

ESC KEY:  Short for Escape, this key is used to send exit/escape from programs and tasks.

DELETE KEY:
Deletes the character at the current cursor position and the one at one right of the cursor position. 
CAPS LOCK KEY: A toggle key that, when activated, causes all alphabetic characters to be uppercase.

END KEY: Moves the cursor to the end of the line, the end of the page, or the end of the file.
CTRL KEY: Short for control, this key is used in combination with other keys to produce special characters. The meaning of each control character depends on which program is running.

ALT KEY: Short for Alternate, this key is used in combination with other keys to produce special characters.

TAB KEY: This key enables the cursor to jump a couple of space to the right on the screen and Shift+Tab to return left on the screen. 

BACKSPACE KEY: Deletes the character present at the left of the cursor.
PAGE UP and PAGE DOWN:
This is used to move the cursor up or down a certain fixed number of lines usually one page at a time. 

HOME KEY:
Moves the cursor to the left corner of the line or to the beginning of the page or file depending where the cursor is and on which program is running.

SPACE BAR:
This key moves the cursor one space to the right every time you press key.

F1
· Almost always used as the help key, almost every program opens a help screen when this key is pressed.

· Windows Key + F1 would open the Microsoft Windows help and support center.
F2:

· Quickly rename a selected file or folder.
· Ctrl + F2 displays the print preview window in Microsoft Word.

F3

· Often opens a search feature for many programs including Microsoft Windows when at the Window Desktop.
· In MS-DOS or Windows command line F3 will repeat the last command.

· Shift + F3 will change the text in Microsoft Word from upper to lower case or a capital letter at the beginning of every word.

F4

· Open the address bar in Windows Explorer and Internet Explorer.

· Repeat the last action performed (Word 2000+).

· Alt + F4 closes the program window currently active in Microsoft Windows.

· Ctrl + F4 closes the open window within the current active window in Microsoft Windows.

F5

· In all modern Internet browsers, pressing F5 will refresh or reload the page or document window.

· Refresh the list of contents in a folder.

· Open the find, replace, and go to window in Microsoft Word.

· Starts a slideshow in PowerPoint.

F6

· Move the cursor to the address bar in Internet Explorer

 HYPERLINK "http://www.computerhope.com/software/ie.htm" , Mozilla Firefox, and most other Internet browsers.

· Ctrl + Shift + F6 opens to another open Microsoft Word document.

· Reduce laptop speaker volume (on some laptops).

F7

· Commonly used to spell check and grammar check a document in Microsoft programs such as Microsoft Word, Outlook, etc.

· Shift + F7 runs a Thesaurus check on the word highlighted.

· Turns on Caret browsing in Mozilla Firefox.

· Increase laptop speaker volume (on some laptops).

F8

· Function key used to enter the Windows startup menu, commonly used to access Windows Safe Mode.

· Used by some computers to access the Windows recovery system, but may require a Windows installation CD.

· Displays a thumbnail image for all workspaces in Mac OS.

F9

· Refresh document in Microsoft Word.

· Send and receive e-mail in Microsoft Outlook.

· Opens the Measurements toolbar in Quark 5.0.

· Reduce laptop screen brightness (on some laptops).

F10

· In Microsoft Windows activates the menu bar of an open application.

· Shift + F10 is the same as right-clicking on a highlighted icon, file, or Internet link.

· Access the hidden recovery partition on Compaq, HP, and Sony computers.

· Enter CMOS Setup on some computers.

F11

· Enter and exit full screen mode in all modern Internet browsers.

· Ctrl + F11 as computer is starting to access the hidden recovery partition on many Dell computers.

F12

· Open the Save as window in Microsoft Word.

· Ctrl + F12 opens a document in Word.

· Shift + F12 saves the Microsoft Word document (like Ctrl + S).

· Ctrl + Shift + F12 prints a document in Microsoft Word.
4.  Some Important Questions and Answers about Windows
What is Windows?

Windows is an operating system which is used to control and manage the system.

Which type of interface windows has?

Windows has graphical user interface (GUI).

What is multitasking?

Ability of doing multiple tasks at same time is called multitasking.
What small pictures on the desktop is called?

Icons.
How can me make new folder?

Right Click on Desktop, select new option then select folder and gave name or use short key Ctrl+Shift+n. 
How can we open a folder?

By double clicking on the folder or press right click then click on open.

What is control Panel?

Combination of different utilities used to perform different system level functions.

When we delete any file, where it goes?

Into the Recycle Bin.

What is the function of Shift + delete key?

To delete file completely from the computer.

What is the purpose of My computer?

My Computer is the place from where we can navigate towards other places.

What first screen of windows is called?

Desktop.

Where can we see the system time?

On the right side on the taskbar.

What we find in the programs option in Start Menu?

Every application which we install in the system.

What is the use of find command?

Using this command, we can find any file in our system.

How can we see the properties of any object using keys?

First, select the object and press Shift + F10.

What is the purpose of refresh option?

This option refreshes the screen and objects.

5.  Some Important Questions and Answers about Internet
What is the use of Browser?

It used to navigate from one to another site.

What is full name of HTTP?

Hypertext transfer protocol.

What is HTML?

It is a language which is used to create the web page. Its full name is Hyper Text Markup Language.

Which device is used to connect computer to the Internet?

MODEM.

What is Internet?

Internet is a network of networks.

Which is the main protocol which handles internet?

Transmission control protocol/ internet protocol (TCP/IP).

What is the Full name of FTP?

File Transfer Protocol.

What is the purpose of domain?

It shows the nature of the site.

What is IP address?

What is the purpose of address bar?

When write site address in this area and can open he desired site.

What is the importance of the internet?
The main importance of the internet is that it has made information available in a quick and easy manner, publicly accessible and within easy reach.


6.  The Most Common Computer Abbreviations

Following are some of the numerous computer abbreviations in use today.

Operating Systems and Data Storage:

BIOS
Basic Input Output System.

DVD 
Digital Versatile Disk.

GPRS 
Global Positioning Radio System.

LASER 
Light Amplification by Stimulated Emission of Radiations.

FAT 
File Allocation Table 

NTFS 
New Technology File System
IBM 
International Business Machine.

HP 

Hewlett Packard.

CAM 
Computer Aided Manufacturing.

CAE 
Computer Aided Engineering.

CAD 
Computer Aided Design.

I/O 
Input/ Output.

LCD 
Liquid Crystal Display.

LED 
Light Emitting Diode. 

FDD 
Floppy Disk Drive.

HDD 
Hard Disk Drive.

HD 
High Definition.

CPU 
Central Processing Unit.
MAC 
Macintosh.
PC 

Personal computer.

PDF 
Portable Document Format.  

VGA 
Video Graphics Array 

SVGA 
Super Video Graphics Array 
Abbreviation related to Internet:

FTP 
File Transport Protocol
HTML 
Hypertext Markup Language 

HTTP 
Hypertext Transfer Protocol 

IP 

Internet Protocol. 

ISP 
Internet Service Provider 

SIM
Simulator Interface Modulation.

PTA
Pakistan Tele Communication Authority.

PTCL
Pakistan Tele communication Limited.

LAN
Local Area Network.

WAN
Wide Area Network.

MAN
Metropolitan Area Network. 

VPN
Virtual Private Network.

PPP 
Point-to-Point Protocol 

URL 
Uniform Resource Locator

USB   
Universal Serial Bus

MSN 
Microsoft Network.

VR 

Virtual Reality
ADSL

asymmetric digital subscriber line

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/avi" \l "avi__1" \o "avi" 
AVI 

audio/video interleaved

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/bak" \l "bak__1" \o "bak" 
BAK 

the last part of the name of a backup file
Bmp 

bitmap

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/bps" \l "bps__1" \o "bps" 
Bps 

bits per second
DPI 
dots per inch

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/eof" \l "eof__1" \o "EOF" 
EOF 

end of file

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/exe" \l "exe__1" \o "exe" 
Exe 

executable file

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/faq" \l "faq__1" \o "FAQ" 
FAQ 

frequently asked questions: 
FTP 

file transfer protocol 
GHz 

gigahertz

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/gif" \l "gif__1" \o "GIF" 
GIF 

Graphic Interchange Format

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/gigo" \l "gigo__1" \o "GIGO" 
GIGO


 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/garbage" \o "garbage" 
garbage
 in, garbage out
IMS 

information management system 
Kbps 

kilobits per second: a unit for measuring the speed of a modem
Mb 

megabyte
MHz 

megahertz

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/mips" \l "mips__1" \o "mips" 
MIPS 

million instructions per second: a unit for measuring computer speed
Org
private organization: used in email and Internet addresses
SEO
search engine optimization
URL 

Uniform Resource Locator
WWW
World Wide Web

 HYPERLINK "http://www.macmillandictionary.com/dictionary/british/xml" \l "xml__1" \o "XML" 
XML 

Extensible Mark-up Language
Some Important Short Keys About windows and formatting the text

	Shortcut
	Description

	Ctrl + 0
	 Toggles 6pts of spacing before a paragraph.

	Ctrl + A
	 Select all contents of the page.

	Ctrl + B
	 Bold highlighted selection.

	Ctrl + C 
	 Copy selected text.

	Ctrl + D
	 Open the font preferences window.

	Ctrl + E
	 Aligns the line or selected text to the center of the screen.

	Ctrl + F
	 Open find box.

	Ctrl + G
	 Open (Go To Dialog Box)

	Ctrl + H
	 Open (Replace Dialog Box)

	Ctrl + I
	 Italic highlighted selection.

	Ctrl + J
	 Aligns the selected text or line to justify the screen.

	Ctrl + K
	 Insert a hyperlink.

	Ctrl + L
	 Aligns the line or selected text to the left of the screen.

	Ctrl + M
	 Indent the paragraph.

	Ctrl + N
	 Opens new, blank document window.

	Ctrl + O
	 Opens the dialog box or page for selecting a file to open.

	Ctrl + P
	 Open the print window.

	Ctrl + R
	 Aligns the line or selected text to the right of the screen.

	Ctrl + S
	 Save the open document. Just like Shift + F12.

	Ctrl + T
	 Create a hanging indent.

	Ctrl + U
	 Underline the selected text.

	Ctrl + V
	 Paste.

	Ctrl + W
	 Close the currently open document.

	Ctrl + X
	 Cut selected text.

	Ctrl + Y
	 Redo the last action performed.

	Ctrl + Z
	 Undo last action.

	Ctrl + Shift + L
	 Quickly create a bullet point.

	Ctrl + Shift + F
	 Change the font.

	Ctrl + Shift + >
	 Increase selected font +1pts up to 12pt and then increase font +2pts.

	Ctrl + ]
	 Increase selected font +1pts.

	Ctrl + Shift + <
	 Decrease selected font -1pts if 12pt or lower; if above 12, decreases  font by +2pt.

	Ctrl + [
	 Decrease selected font -1pts.

	Ctrl + / + c
	 Insert a cent sign (¢).

	Ctrl + Shift + *
	 View or hide non printing characters.

	Ctrl + <left arrow>
	 Moves one word to the left.

	Ctrl + <right arrow>
	 Moves one word to the right.

	Ctrl + <up arrow>
	 Moves to the beginning of the line or paragraph.

	Ctrl + <down arrow>
	 Moves to the end of the paragraph.

	Ctrl + Del
	 Deletes word to right of cursor.

	Ctrl + Backspace
	 Deletes word to left of cursor.

	Ctrl + End
	 Moves the cursor to the end of the document.

	Ctrl + Home
	 Moves the cursor to the beginning of the document.

	Ctrl + Spacebar
	 Reset highlighted text to the default font.

	Ctrl + 1
	 Single-space lines.

	Ctrl + 2
	 Double-space lines.

	Ctrl + 5
	 1.5-line spacing.

	Alt + Space + N
	 To Minimize the activated Window of any Program

	Alt + Tab
	 To active the minimized window of any program

	Alt + Space + R
	 To restore the activated window of any program

	Alt + Space + X
	 To view the activated window on full screen

	Shift + Arrow Keys
	 To select the text by Letter or character

	Shift + Ctrl + 
	 To select the text by word

	Shift + Ctrl +
	 To select the text by Paragraph

	Ctrl + F1
	 Open the Task Pane.

	Ctrl + F2
	 Display the print preview.

	Ctrl + Shift + >
	 Increases the selected text size by one.

	Ctrl + Shift + <
	 Decreases the selected text size by one.

	Ctrl + Shift + F6
	 Switches to another open Microsoft Word document.

	Ctrl + Shift + F12
	 Prints the document.

	Ctrl + Alt + 1
	 Changes text to heading 1.

	Ctrl + Alt + 2
	 Changes text to heading 2.

	Ctrl + Alt + 3
	 Changes text to heading 3.

	Alt + Ctrl + F2
	 Open new document.

	Shift + F3
	 Change the text in Microsoft Word from uppercase to lowercase or a  capital letter at the beginning of every word.

	Shift + F7
	 Runs a Thesaurus check on the selected word.

	Shift + F12
	 Save the open document. Just like Ctrl + S.

	Shift + Enter
	 Create a soft break instead of a new paragraph.

	Shift + Insert
	 Paste.

	Shift + Alt + D
	 Insert the current date.

	Shift + Alt + T
	 Insert the current time.

	Click, hold, and drag
	 Selects text from where you click and hold to the point you drag and  let go.

	Double-click
	 If double-clicking a word, selects the complete word.

	Double-click
	 Double-clicking on the left, center, or right of a blank line makes the alignment of the text left, center, or right aligned.

	Double-click
	 Double-clicking anywhere after text on a line will set a tab stop.

	Triple-click
	 Selects the line or paragraph of the text that the mouse triple-clicked on.

	Ctrl + Mouse wheel
	Zooms in and out of document.
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